[§1 RadioTraffic.com

Welcome to the new Premier

This guide explains enhancements and improvements to your RadioTraffic Premier service.

Release notes

Release Notes are easier to use and review. From the dashboard, click View > Release Notes. The window
can be minimized and maximized. With the notes window open, you can also navigate throughout Premier so
you can compare the notes to the software.

Copy

Copy status is now easily identifiable. Current copy appears in bold in the copy list, and expired copy is grayed
out.

% Copy - | X
File View
Customer <
Cart Name Length Ad-ID Start Date End Date Status

+ Customer: 3M (10)
$999 Test Copy 30 3/7/2016 4/7/2017 OK
$999 Test Copy 30 3/7/2016 4/7/2017 OK
$999 Test Copy 30 3/7/2016 6/30/2017 OK
$999 Test Copy 30 3/7/2016 12/29/2018 oK
11111 Minute cut 80 10/29/2015  12/31/2016  OK
3370 Test #1 30 9/1/2015 12/31/2017 OK
3371 Test #2 30 9/1/2015 12/31/2017 OK
9999 Test copy 2 30 3/7/2016 3/7/2017 OK

» Customer: America's Auto (4)
2300 America's Au... 30 1/1/2015 12/31/2016 OK
2300 America's Au... 30 ThisisanISCL.. 1/1/2014 12/31/2016  OK
3361 Promo Test1 60 1/1/2014 12/31/2016 OK
4001 Muffler Spec... 60 9/24/2015 12/31/2019  OK

» Customer: Bevond The Rock (1) -

New... Close




Removing Expired Copy

Premier now allows you to remove expired copy from your Copy list and place it in your system's Recycle Bin.
Right click a piece of copy and select Trash. Trashed copy is not deleted.

2 Copy — O X
File View
Customer &
Cart Name Length Ad-ID Start Date End Date Status
+ Customer: 3M (9)
$999 Test Copy 30 3/7/2016 4[7/2017 oK
$999 Test Copy 30 3/7/2016 4f7/2017 oK
$999 Test Copy 30 3/7/2016 6/30/2017  OK
$999 Test Copy 30 3/7/2016 12/29/2018  OK
11111 Minute aut a0 10/29/2015 12/31/2016 oK
3370 Test# () Open. 9/1/2015 12/31/2017 0K
3371 Test#{ [} New.. 9/1/2015 12/31/2017  OK
339 Copy1 @ Duplicate.. 10/1/2015 11/30/2015 ¥
9999 Testc 3/7/2016 3/7/2017 oK
) [ wy Trash..
» Customer: Ame
2300 Amerid 2C  Delete... 1/1/2015 12/31/2016  ©OK
2300 Amerid 2 print.. BNISCL.. 1/1/2014 12/31/2016  OK
3361 Promo ) ) 1/1/2014 12/31/2016  OK
4001 Mufflet b Print Preview... 9/24/2015  12/31/2019  OK
v Customer: Beyond The Rock (1)
New... Close

Once a spot has been Trashed it can only be seen by going to View and selecting Trashed. A Trashed spot will
appear with a strike-through.

& Copy - O X
File |View |
v/ Trashed —— .
C w3 Reset..
Car Refresh F5 Length Ad-ID Start Date End Date Status

| + Customer: Bush's Brake Repair (2)

2301 Bush's Brake... 30 1/1/2014 12/31/2016 OK

3346 Test Promo 1 60 1/1/2014 12/28/2016 OK

4

Customer: Candys Campers (9)

v Customer: Colin (1)

1001 Test 30 1/1/2016 12/31/2016 OK
v Customer: Creed Creative Cooking Supplies (3)
2301 Bush's Brake... 30 1/1/2014 12/31/2016 OK -

New... Close




With View Trashed enabled in the copy window, right click the trashed spot and select Un-Trash to restore the
copy to your active copy list.

& Copy - U x
File View
Customer =
Cart Name Length Ad-ID Start Date End Date Status
~ Customer: Bush's Brake Repair (2)
2301 Bush's Brake... 30 1/1/2014 12/31/2016 oK
3346 Test Promo 1 60 1/1/2014 12/28/2016  OK
~ Customer: Candys Campers (9)
e o B s 4
E'E' u Open... PYIVEEYT:
cold New.. 16/4/2045
cel 4 Duplicate... 12045
“| ey Un-Trash.. 10/1/2015
Col 10/1/2015
) x Delete... o
Col 10/1/2015
ol Print... 10/1/2015
Col (4 Print Preview... 10/1/2015
+ Customer: ComvtYy
1001 Test 30 1/1/2016 12/31/2016  OK
~ Customer: Creed Creative Cooking Supplies (3)
2301 Bush's Brake... 30 1/1/2014 12/31/2016 OK -
New... Close

The default layout of the copy window is grouped by customer, and includes a total number of pieces of copy.

= Copy - 0 X

File View

Customer <

Cart Name Length Ad-ID Start Date End Date Status
+ Customer: Beyond The Rock (1)
1000 Test commer... 30 9/1/2015 12/3/2015

~ Customer: Bush's Brake Repair (2)

2301 Bush's Brake... 30 1/1/2014 12/31/2016  OK
3346 Test Promo 1 60 1/1/2014 12/28/2016  OK

~ Customer: Candys Campers (5)

4 Copy5 15 2015 11/30/201

12015

1

1
0/1/2015

1

1

1/2015

2015

4

Customer: Colin (1)

1001 Test 30 1/1/2016 12/31/2016 oK
+ Customer: Creed Creative Cooking Supplies (3)
2301 Bush's Brake... 30 1/1/2014 12/31/2016  OK
2302 Creed's Crea... 30 1/1/2014 12/31/2016 OK
3347 Test Promo 1 60 1/1/2014 12/31/2016 OK N

New... Close




Multi-Select

Multi-Select works in RadioTraffic in a similar manner as it does in Windows

o To select a consecutive group of files or folders, click the first item, press and hold down the Shift key, and
then click the last item.

e To select non-consecutive files or folders, press and hold down the Ctrl key, and then click each item that
you want to select.

2 Copy - (| X
File View
Customer =
Cart Name Length Ad-ID Start Date End Date Status
3361 Promo Test1 60 1/1/2014 12/31/2016 OK
4001 Muffier Spec... 60 9/24/2015 12/31/2019  OK
» Customer: Beyond The Rock (1)
1000 Test commer... 30 9/1/2015 12/3/2015 oK
= Customer: Bush's Brake Repair (2)
2301 Bush's Brake... 30 1/1/2014 12/31/2016 OK
3346 Test Promo 1 60 1/1/2014 12/28/2016 OK
» Customer: Candys Campers (5)
3334 Copy5 15 10/1/2015 11/30/2015 oK
3385 Copy6 30 10/1/2015 11/30/2015 oK
3386 Copy7 30 10/1/2015 11/30/2015 oK
3388 Copy9 60 10/1/2015 11/30/2015  OK
» Customer: Colin (1)
1001 Test 30 1/1/2016 12/31/2016  OK
» Customer: Creed Creative Cooking Supplies (3)
2301 Bush's Brake... 30 1/1/2014 12/31/2016 OK -
New... Close




Contracts

While in the Contract window, you can use arrow keys to navigate between the customer list and contract list.
The Status column in the default view of the Contracts window shows the following statuses:

e Pending - The contract is pending approval.

¢ Running - Spots on the contract are placed on current logs.

e Completed - All spots on the contract have aired and are on the invoice.

e Paid - All related invoices for this contract has been paid.

e P. Canceled - Pending Canceled

e Canceled - Canceled during or after running

e Archived - This contract has been trashed so it doesn't appear in the active contracts window.
e Aborted - Canceled prior to start date

' "RadioTraffic.com - Contracts - =%
File View Tools

Customer - J Contracts ”F’mm‘

3M |Con.., v ‘St’atus |StartDm ‘EndDarz |Reven... ‘Reven... ‘meue |Salest ‘Primarm |Esﬁma... ‘Product
America’s Auto 381 Pending  4/25/2016 5/20{2016 Local A... Trade2 40.00 Nore]  Manufa...

Beyond The Rock 380 Aborted  9/1/2016 2/4/2017 Local A... Cash 1570.00 [None]  Manufa...

Bush's Brake Repair 375 Completed 4/25/2016 5/20/2016 Local A... Trade2 40.00 [Nore]  Manufa...

Calin 374 Running  3/13/2016 9/9/2017 Local A... Cash 22992.00 Sammy ... Commer...

Creed Creative Cooking Supplies . A

David Bowie’s 638 341 Completed 5/2/2016 5/8/2016 Local A... Trade2 280.00 Eddie V... Manufa...

Elvis' Barbeque 2014 3 2 5/2/2016 5/8/2016 Loc ade2 280.00 Eddie A

Example 2 329 Completed 5/9/2016 5/15/2016 Local A... Trade2 2583.00 Eddie V... Manufa...

Example 5 327 Completed 5/9/2016 5/15/2016 Local A... Trade2 17.22 Eddie V... Manufa...

Geneesis Grocery ~id - ach - - -

Hole Repair 2 322 Running  3/11/2016 9/9/2017 Llocal A... Cash 23068.00 Sammy ... Commer...

Incubus New Age Shop ; 319 Running  3/11/2016 9/9/2017 Local A... Trade2  23068.00 Sammy... Commer...

Integrated Sports [ 318 Rumning  3/11/2016 9/9/2017 Local A... Cash 23068.00 Sammy ... Commer...

Joe's Italian MeatMarket D o - - ch e N

Korn Kleaner 253 Running  3/11/2016 9/9/2017 Llocal A... Cash 23068.00 Sammy ... Commer..,

Linkin Park Prescriptions

Megadeth Metal Supply

Must Fill

Nirvana's Hand Guns

No Info

Oasis Spa & Bath

Papa Roach's Bug Conrol

QBS

Red Hot Chili Pepper Spices

Test

Xray's Fiber Glass Supply s New... Close

Inactive contracts are grayed out so current contracts are easier to see.



You can also archive contracts, which speeds up load time for the Contract module.

Archived orders will be faded out and a strike-through them and can be seen by enabling
View > Trashed.

* RadioTraffic.com - Contracts = a X

File |View| Tools

v/ Trashed | = Contracts | Projections
%3 Reset... ~ | Agency Balarice Con... v Status StartD... EndDate Reven... Reven... Revenue SalesP... Primar... Estima... Product =

Refresh  F5 el ] 381 Pending  4/25/2... 5/20/2... LocalA... Trade2 40.00 [None]  Manuf...
.n;}r;é;rza'?Aiﬁi 9426 00; 380 Aborted 9/1/2016 2/4/2017 Local A... Cash 1570.00 [None] Manuf...
Beyond The Rock E_TEST (Tras 0.00 375 Comple... 4/25/2... 5/20/2... Local A... Trade2 40.00 [None] Manuf...

= 374 Running  3/13/2... 9/9/2017 Local A... Cash 22992.00 Sammy... Comme...
Bushg'sBrakeRepalr 6166 373 Archived 5/1/2016 5/20¢ Local-A 8000 § 1 Manuf
Corvby Comacrs LR o Sy S - >
Colin 412.50
348 5/2/2016 5/8/2016
Eompans . 5/2/2016 5/8/2016 . TFrade o
341 Comple... 5/2/2016 5/8/2016 Local A... Trade2 280.00 Eddie V...

Country-Carpet-ScFurniture
Creed Creative Cooking Supplies 1595.00 X
avil Bowis BAB: g 329 Comple... 5/9/2016 5/15/2... Local A... Trade2 2583.00 Eddie V... Manuf...
ErWKNR-AM—ESAN-All-Night 327 Comple... 5/9/2016 5/15/2... Local A... Trade2 17.22 Eddie V... Manuf...
Elvis-Barbeque
Elvis' Barbeque 2014 80.00 322 Running  3/11/2... 9/9/2017 Local A... Cash 23068.00 Sammy... Comme...
Example-1 .00 319 Running  3/11/2... 9/9/2017 Local A... Trade2 23068.00 Sammy... Comme...
Example 2 0.00 318 Running  3/11/2... 9/9/2017 Local A... Cash 23068.00 Sammy... Comme...
Example—t
Example 5 0.00 253 Running  3/11/2... 9/9/2017 Local A... Cash 23068.00 Sammy... Comme...
Geneesis Grocery 8874.00 s
i e B fis 2 3
Hole Repair 0.00 = . =
B . =
Incubus New Age Shop EMPOWER M... 0.00 Close

Informational glyphs call your attention to contract fields that are different from the customer defaults in the
Contract and Line Item windows. In the following example the Agency and Primary conflict were changed from
customer defaults.

* Contract - 381 ? X

File View Tools

Customer ™M v Agency Commission % 0 Revenue Source Local Agency v
Agency EMPOWER MEDIAMKTG  ~ @) Sales Commission % ) Revenue Type Trade2 -
Sales Person  None - Primary Conflict Manufacturing (Trashed) -9
Estimate # Secondary Conflict None -
P.O. # Billing Cyde Calendar v
Product Invoice Type Detail v
Comment

Item (2) | Rotation (1) | Notes

Line Station  Avail Type StartDate EndDate StartT... EndT... Len... Schedule Rate Qty Total Rotation ‘
1WKRP  Commerdal  4/25/2016 5/20/2016 00:00:00 23:59... 00:30 2,2,2,2,2,0,0 0.00 40 0.00 i
New... Off-Air Revenue... +44 (+40.00) = 44 (40.00)

OK

C: 5/24/2016 17:17 Cory Smith




The following contract fields can be changed at any time without Correction Mode:

In the main contract window

e Invoice Types
e Secondary Conflict

In the line items in the contract

¢ Placement
o Avail Type

" Contract - 374 ? X

File View Tools

Customer Agency Commission % ( Revenue Source

Agency t (1] Sales Commission % ( (1] Revenue Type (1]
Sales Person | o Primary Conflict 1)
Estimate # Secondary Conflict None -
P.O. # Billing Cycle (1]
Product Invoice Type Time/Rates -0
Comment

Item (5) | Rotation (3) | Notes

Lline Staton AvalType  StartDate EndDate StartT.. EndT... Len... Schedule Rate Qty Total Rotation |
I 1 KLMIFM Commercial  3/13/2016 9/9/2017 06:00:00 00:30 3,3,3,3,3,0,0 12.00 1170 14040.00 i
2 KEPD-FM Commercial  3/13/2016 9/8/2017 12:30:00 18:00... 00:30 2,2,0,2,2,0,0 8.00 624 4992.00
3 WEEY-... Commercal  3/13/2016 12/31/2... 00:00:00 23:59... 00:30 2,0,2,0,2,0,0 12.00 252 3024.00
4 KLMI-FM 3/13/2016 9/8/2017 12.00 78 936.00
5 WKNR-... Commercial  3/13/2016 12/23/2... 00:00:00 23:59... 00:30 2,2,2,2,2,0,0 0.00 410 0.00

#2534 (22992.00), 1378 (-2944.00) = 2156 (20048.00)

OK

C: 5/19/2016 20:33 Cory Smith | A: 4/27/2016 07:42 Cory Smith |



Spot Detail

You can select multiple spots at once in the Spot Detail window as explained in the Copy — Multi-Select section
above.

Spot Detail ? X
File View
Station <
Contract # Line # S.Target Date Log Date Inv Date Spot Status OAR
~ Station: KEPD-FM (624)
374 2 3/14/2016 Trash
374 2 3/14/2016 Trash
374 2 3/15/2016 Trash
374 2 3/15/2016 Trash n
374 2 3/17/2016 Trash 3
374 2 3/17/2016 Trash -
374 2 3/18/2016 Trash
374 2 3/18/2016 Trash
374 2 3/21/2016 Trash
374 2 3/21/2016 Trash
i374 2 3/22/2016 Trash
374 2 3/22/2016 Trash
374 2 32412016 Trash
Close




Customer List

The Balance column is shown in the customer list default view.

* 'RadioTraffic.com - Contracts

- = x
File View Tools
— Conracts | projecons |
America's Auto [con... v [staws |[startp... | Endate [Reven... [Reven... |Revenue | salesp... | primar... |Estma... |Product |
Geneesis Grocery 381 Pending  4/25/2016 5/20/2016 Local A... Trade2 40.00 [None]  Manufa...
380 Aborted  9/1/2016 2/4/2017 LocalA... Cash 1570.00 [None]  Manufa...
Creed Creative Cooking Supplies 1585.00 375 Completed 4/25/2016 5/20/2016 Local A... Trade2 40.00 [None]  Manufa...
Example 2 787.57 374 Running  3/13/2016 9/9/2017 Local A... Cash 22992.00 Sammy ... Commer...
Colin 412.50 349 Paid 4/20/2016 5/15/2016 Local A... Trade2 200.00 [None] Manufa..
Nirvana's Hand Guns 375.00 341 Completed 5/2/2016 5/8/2016 LocalA... Trade2 280.00 Eddie V... Manufa...
Test 200.00 340 Paid 5/2/2016 5/8/2016 Local A... Trade2 280,00 Eddie V... Manufa...
Elvis' Barbeque 2014 80.00 329 Completed 5/3/2016 5/15/2016 local A... Trade2 ~ 2583.00 EddieV... Manufa...
Yandee's Gourmet Cookie Company 0.00 327 Completed 5/9/2016 5/15/2016 Local A... Trade2 17.22 Eddie V... Manufa...
Xray's Fiber Glass Supply 0.00 323 Paid 3/11/2016 9/9/2017 Local A... Cash 23068.00 Sammy Commer...
Red Hot Chili Pepper Spices 0.co| 8 322 Running  3/11/2016 9/9/2017 LocalA... Cash 23068.00 Sammy ... Commer...
Q8s 0.00 I 319 Running  3/11/2016 9/9/2017 LocalA... Trade2  23068.00 Sammy... Commer...
Papa Roach's Bug Conrol 0.00 318 Running  3/11/2016 9/9/2017 LocalA... Cash 23068.00 Sammy ... Commer...
Oasis Spa &Bath 0.00 %1 Aborted  3/14/2016 3/14/2016 Local A... Cash 10.00 [None] f
No Info 0.00 253 Running  3/11/2016 9/9/2017 LocalA... Cash 23068.00 Sammy ...
Must Fill 0.00
Megadeth Metal Supply 0.00
Linkin Park Prescriptions 0.00
Korn Kleaner 0.00
Joe's Italian Meat Market 0.00
Integrated Sports 0.00
Incubus New Age Shop 0.00
Hole Repair 0.00
Example 5 0.00
David Bowie's B&8 0.00
Bush's Brake Repair 0.00 & New... Close ‘

You can customize the Customer list in the Contracts window by using the Column Chooser.

* 'RadioTraffic.com - Contracts

- =X

File View Tools

America's Auto

Beyond The Rock

Bush's Brake Repair
Colin

Creed Creative Cooking Supplies
David Bowie's B&B

Elvis' Barbeque 2014
Example 2

Example 5

Geneesis Grocery

Hole Repair

Incubus New Age Shop
Integrated Sports

Joe's Italian Meat Market
Korn Kleaner

Linkin Park Prescriptions
Megadeth Metal Supply
Must Fil

Nirvana's Hand Guns

No Info

Oasis Spa & Bath

Papa Roach's Bug Conrol
QBs

Red Hot Chili Pepper Spices
Test

Xray's Fiber Glass Supply

]~ | [ contracts [[projectons |

|R:v:n... ‘Revenm |SdesP

[Prmer.. [t ot

A )
Sort Ascending ws | startD... | EndDate |Reven...
1 Sort Descending 4/25/2016 5/20/2016 Local A...
Clear Sorting pried  9/1/2016 2/4/2017 Local A...
i ) mpleted 4/25/2016 5/20/2016 Local A...
= Group By This Column

hning  3/13/2016 9/9/2017 Local A...

ES show Group By Box 4/20/2016 5/15/2016 Local A
Remove This Column mpleted 5/2/2016 5/8/2016 Local A...
15 Column Chooser 1 5/2/2016 5/8/2016 LocalA...
= BestFit npleted 5/9/2016 5/15/2016 Local A...
. mpleted 5/9/2016 5/15/2016 Local A...

Best Fit (all columns) o e
! 3/11/2016 9/9/2017 Local A...
7 Filter Editor... hning  3/11/2016 9/9/2017 Local A...
T I19ROnning  3/11/2016 9/9/2017 Local A...
’ 318 Running  3/11/2016 9/9/2017 Local A...
261 Aborted  3/14/2016 3/14/2016 Local A...
253 Running  3/11/2016 9/5/2017 Local A...

Trade2
Cash
Trade2
Cash
Trade2
Trade2
Trade2
Trade2
Trade2
Cash
Cash
Trade2
Cash
Cash

Cash

40.00 [None]
1570.00 [None]
40.00 [None]

22992.00 Sammy ...

200.00 [None]

280.00 Eddie V...
280.00 Eddie V...
2583.00 Eddie V...
17.22 Eddie V...

23068.00 Sammy

23068.00 Sammy ...
23068.00 Sammy ...
23068.00 Sammy ...

10.00 [None]

23068.00 Sammy ...

Manufa...
Manufa...
Manufa...
Commer...
Manufa
Manufa...
Manufa...
Manufa...
Manufa...
Commer,.,
Commer...
Commer...
Commer...

Manufa

Commer...




Balance, Sales Person, and Agency columns are available.

| RadioTraffic.com - Contracts

File View Tools

America's Auto
Beyond The Rock
Bush's Brake Repair
Colin

Creed Creative Cooking Supplies
David Bowie's B&8

Elvis' Barbeque 2014
Example 2

Example 5

Geneesis Grocery

Hole Repair
Incubus New Age Shop
Integrated Sports

Joe's Ttalian Meat Market
Korn Kleaner

Linkin Park Prescriptions

R ———

| contracts |["projections |

[con... » | stats

Megadeth Metal Supply
Must Fill

Customization

Nirvana's Hand Guns

No Info Balance

Oasis Spa & Bath Sales Person

Papa Roach's Bug Conrol Status

QBS

Red Hot Chili Pepper Spices
Test

Xray's Fiber Glass Supply

349 Paid

340 Paid

323 Paid

261 Aborted

Trade2 40.00 [None]
Cash 1570.00 [None]
Trade2 40,00 [None]
Cash 22992.00 Sammy ...
Trade2 200.00 [None]
Trade2 280.00 Edde V...
Trade2 280.00 Eddie V...
Trade2 2583.00 Eddie V...
Trade2 17.22 Eddie V...
Cash 23068,00 Sammy ...
Cash 23068.00 Sammy ...
Trade2 23068.00 Sammy ...
Cash 23068.00 Sammy ...
Cash 10.00 [None]
Cash 23068.00 Sammy ...

[ startp.... | End Date | Reven... [Reven... [Revenue [ salesp... | Primar...
381 Pending  4/25/2016 5/20/2016 Local A... Manufa
380 Aborted  9/1/2016 2/4/2017 Local A...
375 Completed 4/25/2016 5/20/2016 Local A...
374 Running  3/13/2016 9/9/2017 Local A...
4/20/2016 5/15/2016 Local A..
341 Completed 5/2/2016 5/8/2016 Local A...
5/2/2016 5/8/2016 Local A...
329 Completed 5/9/2016 5/15/2016 Local A...
327 Completed 5/9/2016 5/15/2016 Local A...
3/11/2016 9/9/2017 Local A...
322 Running  3/11/2016 9/9/2017 Local A...
319 Running  3/11/2016 9/9/2017 Local A...
318 Running  3/11/2016 9/9/2017 Local A...
3/14/2016 3/14/2016 Local A...
253 Running  3/11/2016 9/9/2017 Local A...

Commer..

Manufa..

Manufa...

Commer,..

Commer..
Commer..
Commer..
Manufa...
Commer..




Customer Window

Double click on a customer to open the Customer Window.

RadicTraffic.com - Contracts

File View Tools
Customer «  Agency Balance Sales Person Status
Antique Treasures 1100.00 Vicky W Active
Community center 145.00 Videy W Active
Garden Center 664.00 Vicky W Active
Grandpas Groceries 0.00 Vidky W Active
f Jacksons Hardware 300.00 Sales Rep  Active
Mac and Dons RBC Agency 0.00 Vidky W Active
Menards center Lin... Vicky W Active
Omni Theater center Lin... 1328.00 Videy W Active
PSAS/PROMOS Active
TEST PREBILL WEEKLY WVicky W Active

Contracts | Projections

Con... v Status  Start...
262 Running

257 Compl...

5(17/2...
4/22/2...

New...

End Date |Reven... Reven...
6/28(2... Local D... Cash
5/31/2... LocalD... Cash

Revenue Sales ...

1850.00 Vicky W
300.00 Vicky W

Primar...

Hardw...
Hardw. ..

Estima...

Product

SPORT...

Close

From the Copy tab, you can Trash and Un-Trash that customer's copy.

Customer - 7

Mame Jacksons Hardware
ContactInfo | Scheduling | BGiling | Copy | Motes
View
Cart MName Length Ad-ID
1017 Sports Spon... 30
1037 Memarial Da... 30
1038 Spring Sale 30

Status  Active
Start Date End Date Status
4/19/20156 5/31/2016 oK
5/1/2016 5/27/2018  OK
2/15/2016  5/27j2016  OK

OK

O

x




Right-click on a piece of copy and select Trash to remove it from the list of active copy.

Customer - 7 O x
Mame Jacksons Hardware Status  Active -
Contact Info | Scheduling | Billing | Copy | Motes |
View
Cart MName Length Ad-ID Start Date End Date Status
1017 Sports Spon... 30 4/19/2015 5312016  OK
1037 Memarial Da... 30 5/1/2018 5/27/2018  OK
1058 Spripa S El SfisfE0iE e 01 0K
) Open..
g Mew...
& Duplicate...
| qy Trash..
> Delete...
= Print...
|3, Print Preview...
Mew
|
0K Ca Appl
Enable View > Trashed to see trashed copy in the copy list.
Customer - 7 O >
Mame Jacksons Hardware Status  Active -
| Contact Info | Scheduling | Billing | Copy | Motes |
| View |
caislia Length Ad-ID StartDste EndDate Status
x7  Reset.. Son... 30 4/19/2015  5/31/2016  OK
Refresh 5 |Da 30 5/1/2016  5/27/2018  OK
=l 30 2/15/2016 5/77j2016  OK
Mew
|
0K Ca Appl




Trashed copy appears in the list with a strike-through. Right-click and select Un-Trash to add copy to the list of
active copy.

Customer - 7 O x

Mame Jacksons Hardware Status  Active -

ContactInfo | Scheduling | BGiling | Copy | Motes

View
Cart MName Length Ad-ID Start Date End Date Status
1017 Sports Spon... 30 4f19/2016  5/31/2016  OK
L oating it SHFREE R EEeTe T Frashed
1037 Memarij ) Open... 5/1/2015 5(27/2018  OK
1038 Sprirerd ) New.. 2I5l816  5E2A816 Frashed
& Duplicate...
| nf  Un-Trash...
X Delete...
=] Print...
&, Print Preview..,
New...

OK




Log Editor

Use the delete key to bump an individual spot instead of adding a Bump column to the editor to reduce noise
and conserve real estate of the Log Editor window.

The Log Editor allows you to make changes to your log templates. After modifying the structure of a log — such
as adding a new break to every hour in a daypart — RadioTraffic will place an orange bar with the question
"Apply the changes made to the structure of this log to future [DayOfTheWeek]?" If you check, this every
DayOfTheWeek from then on will match changes you have made.

# Log - WKRP - Saturday 5/28/2016 * — ] b4
File View Tools Log
Station: |WKRP o &8 A P ¥ & 4 | o001 0203040506070809 101112 13 14 15 16 17 18 19 20 21 22 23
Apply the changes made to the structure of this log to all future Saturdays?
Avail Time = FormatName Length (Cap) Length (Avail) Unit (Cap) Unit (Awvail)
00:00:00  Commercial 02:00 02:00 4 4
00:00:00 Badger Minute 00:30
B 00:15:00  Commercial 02:00 01:30 4 3
Time « Customer Rate Length Placement Start Time End Time Product P. Conflict S. Conflict
00:15:00 Incubus New Age Shop... 10.00 00:30 5 00:00:00 23:59:59 Commerdial (1m) Commercial (1m)
B 00:30:00 Commercial 02:00 01:30 4 3
Time 4 Customer Rate Length Placement Start Time End Time Product P. Conflict 5. Conflict
00:30:00 America's Auto (15m) 12.00 00:30 5 00:00:00 23:59:59 Commerdal (1m) Commercial {1m)
00:45:00 Commerdial 02:00 02:00 4 4
01:00:00 Commercial 02:00 02:00 4 4
01:15:00  Commercial 02:00 02:00 4 4
01:30:00 Commercial 02:00 02:00 4 4
B 01:45:00 Commerdial 02:00 01:30 4 3
Time -+ Customer Rate Length Placement Start Time End Time Product P. Confiict 5. Confiict
Bumps (0) | Invalid Copy (0) | ¢& Make Goods (36) Filter By Avail
Customer Rate Length Placement Start Time End Time Quantity Contract # Product P.Conflict Avail Type

Use right and left arrow keys to switch between the Bumps, Invalid Copy, and Make Goods tabs at the bottom
of your log editor window.

¥ Log - DEMO-FM - Wednesday 6/1/2016 - m] X
File View Tools Log
Station: = a LB] A ¥ a2 ] 1= /0001020304050607 080910111213 14 15 16 17 18 19 20 21 22 23
Availl Time = Format Mame Length (Cap) Length (Avail) Unit{Cap)  Unit {Avail) -
00:00:00 Legal ID
00:00:00  Commerdial 03:00 03:00 6 6
B 00:15:00  Commerdial 03:00 02:50 6 5
Time 4 Customer Rate Length Placement Start Time End Time Product P. Confiict S. Conflict
00:15:00 Omni Theater {20m) 0.00 00:10 5 00:00:00 23:59:59 SUMMER. PACKAGE Mursery (5m)
00:30:00  Commerdial 03:00 03:00 6 6
00:45:00  Commerdial 03:00 03:00 6 3
01:00:00  Legal ID
oL mercial 03:00 03:00 6 6
ercial 03:00 03:00 6 6
ercial 03:00 03:00 6 6
erdal 03:00 03:00 6 &
| 1D
02:00:00  Commergal 03:00 03:00 6 3
Er L Aznn & &
IEumDs @ | [21nvaiid Copy (21) | Make Goods (3) Filter By Avai
Sales Person Customer Confract # Time Reason “
Vicky W Antique Treasures 2641 16:30:30 Mo copy found.
Vicky W Antique Treasures 264/1 10:01:30 No copy found.
Vicky W Antique Treasures 2641 13:30:30 Mo copy found.
Viky W Antique Treasures 2641 07:01:30 Mo copy found,
Vicky W Antique Treasures 264/1 09:01:00 No copy found.
Vicky W Antique Treasures 2642 14:31:00 Mo copy found.
Vicky W Antigue Treasures 2642 09:31:30 Mo copy found,
Vidky W Antique Treasures 264/2 17:31:00 No copy found.
Vicky W Jacksons Hardware 262/1 17:45:30 No copy found. -




In the Bumps, Invalid Copy, and Make Goods lists, select multiple spots at once by holding the shift or control
key while clicking.

With multiple spots selected, you can Reschedule ...

# Log - WKRP - Tuesday 5/31/2016 - O X
File View Tools Log
Station: WkP < @ S & 9 @ ¥ 2 ] f 00010203 040506070809 10111213 14 15 16 17 18 19 20 21 22 23
Avail Time  «  Format Name Length (Cap)  Length (Aval) | Unit (Cap) Unit (Avail) =
07:45:00  Commerdal 02:00 02:00 4 4
08:00:00  Commerdal 02:00 02:00 4 4
08:15:15  Commerdal 02:00 02:00 4 4
08:30:00  Commerdal 02:00 02:00 4 4
08:45:00  Commerdal 02:00 02:00 4 4
09:00:00  Commerdal 02:00 02:00 4 4 | |
09:15:00 Commerdal 02:00 0Z:00 4 4
09:30:00 Commerdal 02:00 0Z:00 4 4
09:45:00 Commerdal 02:00 0Z:00 4 4
10:00:00  Commerdal 02:00 02:00 G} 4
10:15:00  Commerdal 02:00 02:00 4 4
10:30:00  Commerdal 02:00 02:00 4 4
10:45:00  Commerdal 02:00 02:00 4 4
11:00:00  Commerdal 02:00 02:00 4 4 .
& Bumps (57) | Invalid Copy (0) | & Make Goods (40) | [ Fitter By Avail
Customer Rate Length Placement Start Time End Time Quantity Contract # Product P.Conflict Avail Type =
Creed Creativ... 10.00 60 01 12:00:00 18:00:00 *2,2,2,2,2,22 3211 Commerdial {1m) Commercial
Creed Creativ... 10.00 = 1:00:00 *2,2,2,2,2,2,2  321f1 Commercial {1m) Commercial
Elvis' Barbeque... 6.75 |[5]  Reschedule... k5050 P il Commerdal (im) Commerdial
Elvis' Barbeque... 6,75 wy  Trash.. :55:59 2,2,2,2,2,22 1 Commerdial {im) Commercial ‘ |
Korn Kleaner {1a) 8.25 30 05 00:00:00 23:55:59 #2,2,3332323 131 Commerdial {1m) Commercial
Korn Kleaner (1a) 8.25 30 05 00:00:00 23:55:59 *2,2,2,2,2,2,2 121 Commerdial (1m) Commercial
Papa Roach's ... 9.00 30 05 00:00:00 23:55:59 *4444444 171 Commercial (1m) Commercial
Papa Roach's ... 9.00 30 05 00:00:00 23:55:59 *4444444 171 Commercial (1m) Commercial
Papa Roach's ... .00 30 05 00:00:00 23:53:59 4444444 171 Commerdal (Im) Commerdal
Papa Roach's ... .00 30 05 00:00:00 23:53:59 4444444 171 Commerdal (Im) Commerdal
(Genesis Grorer 12.00 an 05_00:00-00 23:59:59 =57 532 A1 Commerdial {1m)_Cammercial -
|
... Or Trash spots.
¥ Log - WKRP - Saturday 5/28/2016 — O x
File View Tools Log
Station: WKRP MR~ ] :] @ o T o A il - 0001020304 050607 08091011 1213 14 15 16 17 18 19 20 21 22 23
Avail Time < FormatMName VLengIh (Cap) Length (Avail) VLlnit (Cap) VUnit (Avail) ] I
00:00:00 Commercial 02:00 02:00 4 4
00:00:00 Badger Minute 00:30
00:15:00 Commercial 02:00 02:00 oF 4
00:30:00 Commerdial 02:00 02:00 4 4
00:45:00 Commerdial 02:00 02:00 4 4
01:00:00 Commercial 02:00 02:00 4 4
01:15:00 Commercial 02:00 02:00 4 4
01:30:00 Commercial 02:00 02:00 4 4
01:45:00 Commerdial 02:00 02:00 4 4
02:00:00 Commercial 02:00 02:00 4 4
02:15:00 Commercial 02:00 02:00 4 4
02:30:00 Commercial 02:00 02:00 4 4
02:45:00 Commerdial 02:00 02:00 4 4
03:00:00 Commerdial 02:00 02:00 4 4
03:15:00 Commercial 02:00 02:00 4 4
03:30:00 Commercial . 02:00 02:00 4 4 -
& Bumps (51) | Invalid Copy (0) 1 &8 Make Goods (36) [ Filter By Avail
Customer Rate Length Placement Start Time End Time Quantity Contract # Product P.Confiict Avail Type -
Must Fill (0m) 0.00 &0 01 00:00:00 23:59:59 8,8,8,8,8,8,8 317/2 Commercial (1m) Commerdial
Must Fill (Om) 0.00 60 01 00:00:00 23:59:59 8,8,8,8,8,88 317/2 Commercial (1m) Commercial
Must Fill (Om) 0.00 60 01 00:00:00 = Commerdcial (1m) Commercial
Must Fill (Om) 0.00 60 01 00:00:00 B _Reschedule... Commercial (1m) Commercial
Must Fill (om) 0.00 60 01 00:00:00 [oy  Trash.. Commercial (1m) Commercial
Must Fill (Om) 0.00 60 01 00:00:00 23:59:59 8,8,8,8,8,88 317/2 Commergial (1m) Commercial
Must Fill (Om) 0.00 60 01 00:00:00 23:59:59 8,8,8,8,8,8,8 317/2 Commerdial (1m) Commerdial
Must Fill (Om) 0.00 60 01 00:00:00 23:59:59 8,8,8,8,8,8,8 317/2 Commerdial (Im) Commerdal
Must Fill (Om) 0.00 30 01 00:00:00 23:59:59 8,8,8,8,8,8,8 317/1 Commerdial (1m) Commerdal -




Log Elements can now be managed in the log.

B Log - DEMO-FM - Wednesday 6/1/2016 - o x
File View |Tools| Log
Station: [DE| ) Log Elements » | Avails... |
& Options... Automation Commands...
AvailTime = |Format Name | Log Notes... ) Unit (Avai) B
00:00:00 Legal D 24 Programs... I}
Commercial 0500 [0 5 5
Commercial 03:00 02:50 6 5
~ Customer Rate Length Placement  StartTme  EndTme  Praduct P, Confict 5. Canflict
00:15:00  Omni Theater (20m) 0.00 o0:10 500:00:00  23:5%:59  SUMMER PACKAGE Nursery (5m)
00:30:00  Commercil 03:00 03:00 5 5
00:45:00  Commercial 03:00 03:00 5 5
OO0 Legal D
Commercial 03:00 03:00 6 &
Commercial 03:00 03:00 5 5
Commercial 03:00 03:00 ) 6
01:45:00  Commercil 03:00 03:00 6 &
02:00:00  Legal D
02:00:00  Commercil 03:00 03:00 5 5
nrsnn e . nznn nann
[ Bumps @ | [ invaiid copy (21) | wake Goods (0) [ Fiter By Avail
Sales Person Customer Contract # Time Resson -
Vicky W Antique Treasures 26411 16:30:30 No copy found.,
Vicky W Antique Treasures 26411 10:01:30 No copy found.
Vicky W Antique Treasures 20471 13:30:30 o copy found.
Vicky W Antique Tressures 26471 07:01:30 Wo copy found.,
Vicky W Antique Treasures 26411 09:01:00 No copy found.,
Wicky W Antique Treasures 264(2 14:31:00 No copy found.
Vicky W Antique Treasures 0472 09:31:30 o copy found.
Vicky W Antique Treasures 26412 17:31:00 No copy found.
Vicky W Jacksans Hardware 26201 17:45:30 No copy found., -

Reduction of noise on non-avail log items.

# Log - WKRP - Saturday 5/28/2016 - O b4
File View Tools Log
Station: | WIKRP - aoE&S& 9 ¥ 2 4 § 0001 020304050607 08091011 12 13 14 15 16 17 18 19 20 21 22 23
Avail Time =~ Format Name Length (Cap)  Length (Avail)  Unit (Cap) Unit (Avail) -
00:00:00  Commerdcial 02:00 02:00 4 4
i Badger Minute 00:30
Commercial 0 01:30 4 3
-  Customer Length Placement Start Time End Time Product P. Conflict S. Conflict
Incubus New Age Shop... 10.00 00:30 5 00:00:00 23:59:59 Commercial (1m) Commercial (1m)
Commercial 02:00 01:30 4 3
- Customer Rate Length Placement Start Time End Time Product P. Confiict S. Confiict
00:30:00 America's Auto (15m) 12.00 00:30 5 00:00:00 23:59:59 Commerdial (1m) Commerdial (1m)
00:45:00 Commercial 02:00 02:00 4 4
01:00:00  Commerdial 02:00 02:00 4 4
Commercial 02:00 02:00 4 4
Commercial 02:00 4 4
Commercial 01:30 4 3
- Customer Length Placement Start Time End Time Product P. Conflict S. Conflict
01:45:00 Papa Roach's Bug Conr... 9.00 00:30 5 00:00:00 23:59:59 Commerdial (1m) Commerdial (1m) -
Bumps (0) [ Invalid Copy (0) I &8 Make Goods (36) [] Filter By Avail

Customer Rate Length Placement Start Time End Time Quantity Contract # Product P.Conflict Avail Type




Accounts Receivable

Current transactions in the Accounts Receivable window are dark black, while concluded or pending items are
grayed out, drawing your eye to only transactions that require your attention.

The Balance column is included in the default view of the A/R window.
Use right and left arrow keys to toggle between the Customer and Transaction lists.

Debit and Credit columns in the Transaction list are cleaner with only numbers in the appropriate columns
instead of showing zero-dollar values.

& RadioTraffic.com - Accounts Receivable = x

File View Tools Reports

P | Batance Transactions | Statement
M 2895.42 | | pate Transaction Status Invoice Station Sales Person Debit Credit Balance 4
Beyond The Rock 0.00 J
Bush's Brake Repair 0.00
Candys Campers 0.00
Colin 41250
Creed Creative Cooking Supplies 1595.00
Devid Bowie's 580 o Gathering invoices
Eivis' Barbeque 2014 80.00 are italicized.
Example 2 0.00
Example 5 0.00
Geneesis Grocery 8874.00
Hole Repair 0.00
Incubus New Age Shop 0.00
Integrated Sports 0.00
Joe's Itakan Meat Market 0.00
Korn Kieaner 0.00 Important items
Linkin Park Prescriptions 0.00 A are bold can
Megadeth Metal Supply 0.00 7”7 easily seen.
Must Al 0.00
Nirvana's Hand Guns 375.00
No Info 0.00 ks
Ousis Spa &8st 0.00 1! 571972016 Credit Adjustment / 0.00 0.00
Papa Roach's Bug Conrol 0.00 /
Q8s 0.00
Red Hot Chili Pepper Spices 0.00
Test 0.00 |/ 5/6/2016 Invoice Printed 3716 KLMIFM Franke Valen 540.00 540.00
Xray's Fiber Glass Supply 0.00 52219.25 46389.50 540.00|
Yandee's Gourmet Coolde Comp. 0.00
14771.92 Add Payment... Add Adjustment...

The use of color in the A/R window is only to highlight invoices under the following conditions:
¢ An invoice highlighted in yellow means it has past the end date for that billing cycle by up to 10 days.
¢ An invoice highlighted in orange means is past ten days.
e An invoice highlighted in red means you have a significant problem. Please call Tier 1l support directly
at 817-400-4335 for assistance.



You can Trash and Un-Trash customers from the A/R window. Again, the customer is not deleted, but
removed from your list of active customers to improve loading times of the Accounts Receivable module.

Right-click a customer and select Trash.

&% RadioTraffic.com - Accounts Receivable - = x
File View Tools Reports
hcushom:r Balance |: J Transactions | Statement
3™ 2438.42 | Date I Transa... J Status I Inv... ~ |Station | SalesP... | Debit Balance | *
America's Auto 9426.00 5/3/2016 Payme 0.00
Beyond The Rock 0.00
Bush's Brake Repair 0.00
Colin 412.50
Creed Creative Cooking Supplies 1595.00
David Bowie's B&B 0.00
Elvis’ Barbeque 2014 80.00
Example 2 787.57 |= 4
Geneesis Grocery L3 Open... 8374.00 7
Hole Repair [ New.. 0.00
Incubus New Age| oy Trash... | 0.00
Integrated Sports 0.00 7
Joe's Italian Meat Market 0.00 -
Korn Kleaner 0.00
Linkin Park Prescriptions 0.00 2
Megadeth Metal Supply 0.00 - . - B
Must Fill 0.00 - - 4 -
Nirvana's Hand Guns 375.00
No Info 0.00 8 & 454 75
Oasis Spa &Bath 0.00 | [ 3277.50|| 0.00| o
Papa Roach's Bug Conrol 0.00
24188.49 | | AddPayment... || Add Adjustment... |
|

Enable View > Trashed. Trashed customers appear on the list with a strike-through. Rick-click on a trashed
customer and select Un-Trash to restore it to the list of active customers.

&% RadioTraffic.com - Accounts Receivable - = x
File View Tools Reports
|Custnmer iﬂdmm ‘: J Transactions |
America’s Auto 9426.00| | |lpate  [Transa... [Status |Invoice 4 |station | SalesP.. |Debit | Balance
Beyond The Rock 0.00|_
Bedoriotfoeiion 1
Bush's Brake Repair 0.00
Candys-Campers [- 973
Colin 412.50
T
Eemf|_) Open..
Eouf 1 New...
Cree| wf Un-Trash... | 1595.00
Davitr 0.00
BEEFADENTAL B8-85
EVANR-AM—ESPN-Al-ght
Eivis'B
Elvis’ Barbeque 2014 80.00
Examstet 586
Example 2 787.57
Ewamoke3
]
Semesleh e
Frey-Communicationsine
Geneesis Grocery 8874.00 | a 0 ‘
HETr-ard-Electromes
24188.49 ‘ = Add Payment... | | Add Adjustment... |




Use the balance column to filter out transactions you don't need to see for a cleaner A/R window.

& RadioTraffic.com - Accounts Receivable - = x
File View Tools Reports

r— [odorce || Taractans | ttement |

kY 243842 ||lpate  [Transa... [Status |Invoice  |station |salesp... |Debt  |Balance |
America's Auto 9426.00 7/31/2015 Invoice  Printed  32-1 WKNR-AM Sammy...  204.00  204.00
Beyond The Rock 0.00 8/31/2015 Invoice  Printed  32-2 WKNR-AM Sammy ... 117525  1175.25
Bush's Brake Repair 0.00 9/30/2015 Invoice  Printed 323 WKNR-AM Sammy.. 128250  1282.50
Colin 412.50 11/30/2... Invoice  Printed  32-5 WKNR-AM Sammy.. 128250  1282.50
Creed Creative Cooking Supplies 1595.00 1231/2... Invoice  Printed  33-13  WKNR-AM Sammy... 132525  1325.25
David m - 3/31/2016 Invoice  Printed  33-16  WKNR-AM Sammy...  1325.25 42,75
Eivis' Barby 4/30/2016 Invoice  Printed  33-17  WKNR-AM Sammy... 128250  1282.50
Example 2| And © =|/|/3/31/2016 Invoice Printed 366 WKRP Sammy .. 122400  1127.25
ebaaahl - [Balance] Is greater than 0.00 /& 4/30/2016 Invoice  Printed  36-7 WKRP Sammy ... 115200  1152.00
Hole Repal

Incubus N

Integrateg

Joe's Italia Less Noise

Korn Klear|

Linkin Park

Megadeth

Must Fill

Nirvana's i B

No Info

Oasie Spa i l | 10253.25) 887400
Papa Road | — ‘ | Gancel | k Apoly. * x [¥] [Balance] > '0.00" ~ Edit Filter

- 0,00

|£E " 2ams). | addPayment... || AddAdustment... |
—

Using the Column Chooser, you can add Agency, Aging, Sales Person, and Status to your Customer list in the
A/R window.

| & RadioTraffic.com - Accounts Receivable S—
File View Tools Reports
[cmener [ssiree ||| Torsacs [ smment |
Y 24842 | |[pate |Transa... |Status | Invoice ~ | Station | SalesP... | Debit | Balance |
America's Auto 9426.00 5/3/2016 Payment 0.00
Beyond The Rock 0.00 2{28/2016 Payment KLMI-FM  Sammy ... 0.00
Bush's Brake Repair 0.00 1/18/2016 Payment 0.00
Colin 412.50 1/18/2016 Payment KLMI-FM 0.00
Creed Creative Cooking Supplies 1595.00 12/31/2... Invoice  Printed  193-1 KLMIFM  Sammy ... 30.00 0.00
David Bowie’s B&8 0.00 1/31/2016 Invoice  Printed 1932 KLMIFM  Sammy ... 62.00 0.00
Eivis' Barbeque 2014 80.00 2/29/2016 Inveice  Printed 1933 KIMIFM  Sammy... 58.00 0.00
Example 2 787.57| ||| 3/31/2016 Invoice  Printed 1934  KIMIFM  Sammy... 62,00 0.00
Geneesis Grocery 8874.00 4/30/2016 Invoice  Printed  193-5  KIMIFM  Sammy... 60.00 0.00
Hole Repair 0.00 | 5512016 Invoice  Gathering 1936 KIMIFM  Sammy ... 50.00
Incubus New Age Shop 0.00| |
Integrated Sports 0.00
Joe's Italian Meat Marke Customization x 0.00
Korn Kleaner Pom— 0.00
Linkin Park Prescriptions 0.00
Megadeth Metal Supply pdd 0.00
Must Fill 2 0.00
375.00

0.00

o0 ] EDIEE

0.00
|5E e | AddPayment... || Add Adustment... |




Payment Window

You have the option restrict which invoices a payment can be applied to in the payment window. By changing
the value in the Station, Revenue Source, Revenue Type, or Sales Person fields from Any, payments can only
be applied to invoices with those exact values. We strongly recommend that you leave those values as Any.

Payment - NEW ? *
Date 5/27/2016 - Amount (1] Station DEMOFM -
Type hedk P Check # Revenue Source | Any -
Comment Revenue Type  Any b
Sales Person Any -

0 item({s) applied............ 0.00

FEMEINING. . vvverinn 0.00

Date Invoice Description Balance Applied
4f30/2016 260-1 May Auction 150.00 0.00
5/26/2016 260-2 May Auction 950.00 0.00
Cancel

When entering a payment amount, hit the Enter key to save the payment and close the window, bypassing the
need to click OK.

Payment - NEW ?

*
Date 5/27/2016 - Amount [15g| — - tion DEMO-FM -
Type Check - Check # Revenue Source  Any -
Comment Revenue Type  Any -
Sales Persaon Any -

0item(s) applied.

FEMININGsevivins
Date Invoice Description Balance Applied
4f30/2016 260-1 May Auction 150.00 pay 0.00
5262016 260-2 May Auction 950.00 pay 0.00

0K Cancel Apply




Reports

Each station has its own Inventory Report to speed loading time and eliminate the need to filter out multiple
stations.

E RadioTraffic.com - Select Report — *
File View
Category =
MName Description

Make Good Details contracts containing spots scheduled during the report period that need to be made qoo...
SEDt Rate Iaeta Details SEDt rates based on entered contracts running between two dates,

- Category: Inventory
Inventory (WKRF) Estimates how much of your broadcast inventory for WERP is sold and/or unsold based on the ...
Inventory (WKNR-AM) Estimates how much of your broadcast inventary for WEMNR-AM is sold and/or unsold based on t...
Inventory (KEFD-FM) Estimates how much of your broadcast inventory for KEPD-FM is sold andjor unsold based on th...
Inventory (WSM-AM) Estimates how much of your broadcast inventory for WSM-AM is sold and/or unseld based on th...
Inventory (KLMIFM) Estimates how much of your broadcast inventory for KLMIFM is sold and/or unsold based on th...

¥ Category: Log
After Aired Print report showing customer spots on logs.
Bump Details all spots currently on the bump list during the report period.
Log Details each item that invoiced per customer scheduled for logs during the report period; indude. ..
Log Time Detail list of dates/times for each item that invoiced for each customer of what aired on logs dur...
Off Air Revenue Detailz off air revenue that will bill {or have billed) during the report period.

- Category: Sales
Commission [beta] Details commission based on inveoicing and collections.
Revenue Projection Details expected revenue over the next 3 months based on approved contracts,
Revenue Projection {Accrual) Details expected (accrual) revenue over the next 3 months based on approved contracts, -

Laundh... Close

Settings

In several of the Settings windows, you now have the column chooser to add a variety of columns.



The Dashboard

Tools

We have added the ability to change your password and sign into a support meeting via Join.me.

[&1 RadioTraffic.com Premier - O X
File View |Tools| Feedback Support

A There are | Change password... od.

W Start joinme

@ Reset *all* layouts...

O m ) &) & &

Copy Contracts Logs Biling Accounts Settings
Receivable

[QAZ] | ashleyblyth | traf7.net | QA2 | 04:20 v1868

Change password allows you to change your RadioTraffic.com password. For your security and protection,
your previous password must be entered before you can select a new password.

Change Password

Previous Password

9
New Password [y ]
9

Confirm Password




If we need to see your screen, we will ask you to navigating to Tools > Start Join.me from your RT dashboard.
That will open a Web browser pointed to Join.me.
[& RadioTraffic.com Premier - O X

File View |Tools| Feedback Support

| There are | Change password...

Start join.me

@ Reset "all* layouts...

-

S = 8 ¢

iling Accounts Settings

Receivable

L m )

Copy Contracts Logs

i ]

]

[OAZ] | ashleyblyth | traf7.net | QA2 | 0420 v1868

Click the white Join Meeting link at the top of the page.

’ 4 . P M—> Join Meeting Log In e

Collaborate instantly with free screen sharing, unlimited audio, and ridiculously simple

video conferencing. No registration required

|
We will give you a 9-digit meeting code to enter in the Join box at the top of the page.

Click Join and you will
enter the 9 digit meeting
code here that we give
you.




Feedback

Feedback is our new feature that allows you to directly contact us either via the Peer Forums or by sending us
a Smile or a Frown.

Did you have a good day? Did RT contribute to that? Send us a smile to let us know! Had a a bad day? Did RT
contribute to that? Send us a frown to let us know that as well!

[id RadioTraffic.com Premier - O X
File View Tools | Feedback | Support

(] There are 40 spots| & Send a Smile...

Send a Frown...

g% PeerForums..

|— . E ™ J_ = B
L B 3 & B @ -
Copy Contracts Logs Biling Accounts Settings
Receivable
[QAZ] | ashleyblyth | trafi.net | QA2 | 10:44 w1868

e Send a Smile allows you to send us a note if we have done a good job or if you like a feature that helps
you out.

e Also, when we address any questions you have or frowns we resolve, we will ask you to send us a
smile to let the other members of our team to know that we finished helping you out.

o Send a Frown if you have a question or a problem; if you have multiple issues, please send us multiple
frowns.

o Peer Forums is the place to share suggestions, feedback on new features, comments on the software,
or general questions for your peers outside your own group. This also the place that where our
developers look for general feedback from our customers for future improvements.



